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1. Introduction 

Purpose of this document 

This document is a writing sample of written instructions, procedures, or a “how-to” document. 

Goal  

The intention in creating this work is to demonstrate an ability to create instructional documentation. 

Requirement  

Create high-quality instructional documentation based on an open-source application. 

Document scope 

The scope of this document includes addressing the following tasks related to using Greenshot:  

• Installing and Opening Greenshot 

• The Greenshot Image Editor 

• Using Some of Greenshot’s Key Features 

• Using and Saving Captured and Edited Images 

Out of scope 

Information not related to the Greenshot application, its installation, and its use are beyond the scope of 

this document (for example, accessing the Greenshot open-source code). 

Sources and licensing considerations 

The basis of this documentation is the open-source Greenshot screen capture and editing software for 

Microsoft Windows. 

Link to download and install Greenshot 

• Click the following link to download and install the Greenshot program: getgreenshot.org/ 

Link to Greenshot licensing information and how licensing relates to this document 

• The Open Hub® page at the following link provides information on Greenshot licensing: 

www.openhub.net/p/greenshot 

Greenshot licensing as it relates to this document 

As of April 13, 2023, the Open Hub page linked above states that Greenshot is licensed under the “GNU 

General Public License v2.0 or later.” Please note the following related points. 

• A popup message for Commercial Use states that the “PERMITTED license permits or expressly 

restricts this software and/or derivatives to be used for commercial purposes.”  

• The page linked above provides the following link to a description of the GNU General Public License: 

www.openhub.net/licenses/gpl 

https://getgreenshot.org/
https://www.openhub.net/p/greenshot
https://www.openhub.net/licenses/gpl
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• The above-linked text of the GNU General Public License v2.0 or later allows “forming a work based 

on the Program [...]” (as of April 13, 2023) and seems to allow for the creation of a document like this. 

• See also the About Greenshot screen image in Figure 1 below for additional reference and copyright 

information regarding Greenshot. 

• Thus, I consider this document to be a work based on the Greenshot program in accordance with the 

relevant license. My intention is to conform to and respect the desires and rights of the Greenshot 

program authors under the licensing terms granted for my use of Greenshot images and descriptions, 

while also retaining whatever copyright rights I legally retain in producing my own materials. 

How this document uses the Greenshot application 

• This document uses and describes Greenshot version 1.2.10 Build 6 (64 bit). 

• This document describes Greenshot’s functionality using written descriptions, explanations, and 

screen images of the Greenshot image editor (the user interface) and functionality. 

• Images in this document of the Greenshot tool are to be created using Greenshot and its functionality. 

• As such, this document is derived from the Greenshot open-source application. 

• The images and descriptions do not modify the Greenshot user interface, except as some images 

contain callouts, arrows, shapes, and text boxes that obscure portions of the Greenshot image editor.  

• This document does not involve working with the Greenshot program’s source code. 

Link to Greenshot GitHub repositories 

The GitHub page linked below provides access to code, issues, and other repository information. 

• github.com/greenshot 

The About Greenshot screen 

The About Greenshot screen located on the Help menu in the Greenshot image editor contains additional 
information and copyright details. 

 

Figure 1: Greenshot About Screen 

https://github.com/greenshot
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Other brand matters and redaction 

Some Greenshot images in this document contains areas that have been redacted due to the presence of 
brand names and images. Greenshot provides features to interact with these brands, but this functionality 
does not pertain to this document and it is not functionality that I have used.  

To avoid further trademark issues or discussion, I have redacted the information where it appears.  

Trademark acknowledgements 

• Microsoft and Windows are trademarks of the Microsoft group of companies. 

• Mac is a trademark of Apple Inc. 

Scott’s background 

I’ve been writing and editing various types of content for over twenty years. My introduction to this work 

came in the late 1990s when I became a training coordinator for a commercial lender. That company put 

me through training in Information Mapping®, which introduced me to idea of considering how content can 

be structured to make it easier for readers to consume.  

In the following years, I went on to earn a BA in English, graduating Summa Cum Laude. My college 

experience included two semesters in a technical writing internship with Hewlett-Packard. A few years 

after graduation, I took my first fulltime position as a technical writer—a contract position working on 

software development lifecycle (SDLC) documentation for a major healthcare information system. 

Most of the technical writing work I’ve done since that contract job has been in healthcare IT, and much of 

that work related to that same major information system. This included more SDLC documentation, 

information security documents, user and system manuals, policies and procedures, help content, and 

user guides. 

Banking is another industry where I’ve worked on documentation. Before my first technical writing job in 

healthcare IT, after 9/11 I helped a bank create procedures and job aids to help employees navigate the 

enhanced regulatory terrain of “Know Your Customer” and its related tasks. My banking experience also 

includes creating and presenting training materials and working as a business analyst to help determine 

business requirements and review/edit use cases for new bank systems and processes.  

Of course, all of the above work involved proprietary and confidential documentation, which highlights my 

need for a document like this that I can share. 
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2. Installing and opening Greenshot 

This section discusses how to download, install, and open Greenshot—a free, open-source tool for 

capturing computer screen images and editing the captured images.  

IMPORTANT: Before downloading or installing Greenshot, it is advisable to perform your 

own due diligence to satisfy yourself as to the safety of the Greenshot program. 

Due diligence could include performing web searches for reviews, security scans (such as 

VirusTotal.com), or reviewing materials and information from the following Greenshot-related sites: 

• getgreenshot.org/ 

• www.openhub.net/p/greenshot 

• github.com/greenshot 

I can state that I have used Greenshot personally and at a former employer with no apparent issues. 

Install Greenshot 

Step 1  

Access the getgreenshot.org/ website. 

Step 2  

Click the Download Now button. 

Step 3  

Click the Latest Stable button—this is the latest version of Greenshot for Microsoft Windows. As of April 

13, 2023, the latest version is1.2.10.6, dated 09 Aug 2017.  

Result: The Greenshot-INSTALLER-1.2.10.6-RELEASE.exe file (or the most current version) should 

appear in your computer’s Downloads folder.  

Note: There is a button to purchase a version for Mac products for $1.99; however, this version is beyond 

the scope of this document.  

Step 4  

Click the Greenshot-INSTALLER-1.2.10.6-RELEASE.exe file (or the most current version) to begin the 

installation, and follow the onscreen instructions to complete the installation. 

Open Greenshot 

Step 1  

Click your computer’s Start button and locate the Greenshot folder in the Start menu. 

• Four files should appear in this folder: Greenshot, License.txt, Readme.txt, and Uninstall Greenshot. 

Step 2  

Click the Greenshot icon to open the program. 

Result: Greenshot is ready to use, although the program does not visibly open.  

https://getgreenshot.org/
https://www.openhub.net/p/greenshot
https://github.com/greenshot
https://getgreenshot.org/
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TIP: For quick access to Greenshot going forward, right-click the Greenshot icon and 

select More > Pin to taskbar. Now when you need to open Greenshot, you only need to 

click the icon on your taskbar. 

Go to Step 3 below to test that Greenshot is open.  

Tip: To add Greenshot to your taskbar so it is easily available, right-click the Greenshot icon in the Start 

menu, and select More > Pin to Taskbar 

Step 3  

To test that Greenshot is open, press the Print Screen key on your keyboard.  

Result: When Greenshot is open and active, a crosshairs selecting tool appears on your screen as 

pictured below—this is the tool you use to select the area of the screen you want to capture. 

 

Figure 2: Greenshot Crosshairs Selection Tool 

As shown in Figure 2, you use the small crosshairs tool to select the area you want to capture, while the 

larger crosshairs area magnifies your selection to give you precise control over the image. 

 

Step 4  

Choose an option to resolve the crosshairs on your screen.   

Option 1: Close the Greenshot screen capture feature by pressing the Escape key on your keyboard. 

Option 2: Capture an image on your screen, as follows:  

• Left-click and hold your mouse button while dragging the crosshairs over the area of the screen you 

want to capture. 

• Release the left mouse button when you have selected the area you want to capture. 

A Greenshot menu appears showing actions you can take for the image you have captured. 



 Using the Greenshot Screen Capture Tool  Page 10 of 39 

Scott Weiss—Technical Writing Sample  Installing and Opening Greenshot 

 

Note:  

Greenshot enables interaction with certain other 

applications. This document does not discuss 

these interactions and the menu options 

showing these brands have been redacted. 

Step 5  

Choose an option from the Greenshot menu. 

• Save ( ) the image by selecting Save as or Save directly. See section 5 for more on saving. 

• Edit ( ) the image by selecting Open in image editor. See sections 3 and 4 for more on editing. 

• Copy ( ) the image by selecting Copy to clipboard. This lets you paste the image to a document. 

• Print ( ) the image by selecting Send to printer—hovering over this option shows the different 

print options you can select for your computer. 

• Close ( ) the Greenshot menu by selecting Close. 

 

See also 

• The Greenshot Image Editor 

• Using Some of Greenshot’s Key Features 

• Using and Saving Captured and Edited Images 
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3. Greenshot image editor 

The Greenshot image editor only opens after you capture an image using the Greenshot image capture 

tool and select the option to open it in the image editor.  

Figure 3 below points out the elements of the Greenshot image editor. The Menu Options section below 

discusses these elements in more detail.  

 

Figure 3: Options on the Greenshot User Interface 

 

Notes: 

• Brand information has been redacted (blacked-out) from the horizontal toolbar. 

• The object formatting toolbar only appears when an object has been inserted and is selected 
or has focus. The visible formatting options change dynamically depending on the type of 
object selected. See the Object Formatting Toolbar Options section below for more. 
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Menu options 

The Greenshot image editor user interface includes File, Edit, Object, and Help menus, as outlined here. 

 

The following table describes each Greenshot menu and the elements discussed in this document. 

Menu name and description Menu image 

File 

The File menu contains many of the options found 

on the horizontal toolbar.  

 

It also has the Save directly option and the Close 

option. 

 

Note: Greenshot enables interaction with some 

branded applications, which this document does 

not address. The brands have been redacted. 

 

Edit 

The Edit menu contains several options found on 

the horizontal toolbar. Note: The Copy function on 

the toolbar copies the entire image; the Copy 

function on this menu copies a selected element. 

 

It also has a Duplicate selected element option, 

Auto crop, and Insert window options. 

 

Object 

The Object menu contains most of the options 

found on the vertical toolbar. 

 

It also has Select all, Arrange, Save objects to 

file, and Load objects from file options. 

 

The Delete option on this menu appears on the 

horizontal toolbar. 
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Menu name and description Menu image 

Help 

The Help menu lets you access Greenshot help 

information on the web and provides an About 

Greenshot option to find version details and other 

Greenshot information.   

 

Horizontal toolbar 

The horizontal toolbar pictured in Figure 4 below provides File menu and Edit menu functionality. Note 

that brand-name icons have been redacted from the image.  

 

Figure 4: The Horizontal Toolbar 

 

The following list addresses the horizontal toolbar functionality in order as it appears from left to right on 

the toolbar. 

• Save ( ): Clicking the Save icon on a new image opens the Save As window, allowing you to save 

the image file where you want with the file name you want to use. Clicking the Save icon after the 

initial save saves changes to the image file in the same location you chose before. 

• Copy image to clipboard ( ): Clicking the “Copy image to clipboard” icon copies the entire image, 

including any added object, to the clipboard so you can paste it into another application.  

• Print ( ): Clicking the print icon opens a print window where you can choose the print method. 

• Delete ( ): This icon is only active when an object has been added to the image and is selected (has 

focus). Otherwise, it is grayed-out. Clicking this icon deletes the selected object from the image. 

• Cut ( ): The cut icon is only active when an object has been added to the image and is selected 

(has focus). Otherwise, it is grayed-out. Clicking it removes the object from the image and adds it to 

the clipboard, so you can use paste functions to paste it. You can also use the Edit menu option or 

Ctrl+X. 

• Copy ( ): The copy icon is only active when an object has been added to the image and is selected 

(has focus). Otherwise, it is grayed-out. Clicking the copy icon adds the selected object to the 

clipboard, so you can paste it using paste functions. You can also use Ctrl+C or the Edit menu option. 

• Paste ( ): The paste icon is only active when an item has been copied to the clipboard. Use it, 

Ctrl+V, or the Edit menu option to paste an object from the clipboard onto the current image.  

• Undo ( ): Use the Undo icon, Ctrl+Z, or the Edit menu option to undo your most recent action. 

• Redo ( ): Use the Redo icon, Ctrl+Y, or the Edit menu to undo your most recent action. 

• Properties ( ): The properties icon gives you quick access to change properties. 
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Object formatting toolbar 

The object formatting toolbar options include tools to change background color, line color and thickness, 

font settings, and more. The available options change with each type of object selected.  

The options for each toolbar item are discussed in section 4, Using Some of Greenshot’s Features.  

Vertical toolbar 

The vertical toolbar shown in Figure X below gives you handy options for editing images and adding a 

variety of objects.  

Vertical Toolbar Icons with Brief Descriptions 

 

Select Tool: Select an object to change, move, format, or delete it.  

Draw Rectangle: Adds a rectangle or square that you can shape or size to suit your needs.  

Draw Ellipse: Inserts an ellipse that you can shape as an oval or a circle.  

Draw Line: Creates a straight line.  

Draw Arrow: Drags an arrow into place.  

Draw Freehand: Draw lines with your mouse.  

Add Textbox: Add a textbox to your image.  

Add Speechbubble: Add a text bubble (callout) to your image with a moveable pointer.  

Add Counter: Each mouse click adds a new counter object that increments by one. 

Highlight: Adds highlighting to your image.  

Obfuscate: Lets you blur areas of your image—works great for masking sensitive data.  

Effects: Add a border, drop shadow, torn edge, grayscale, or invert colors/light-dark. 

Crop: Crops the entire image to the area you select. 

Rotate Clockwise: Rotates the image—useful for images of document pages. 

Rotate Counter Clockwise: Rotates the image—useful for images of document pages. 

Resize: Lets you set the height and width of your image in pixels or by percentage.  

Formatting options for each object appear on the horizontal toolbar when the object is selected. 

See the Using Some of Greenshot’s Key Features section for more on working with these objects. 
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4. Using Greenshot 

To use the features in this section, you need to capture a screen image and choose to open it in the 

Greenshot image editor. 

Greenshot tool names appear with first-letter caps in this guide, even when the Greenshot image editor 

does not use first-letter caps. For example, the “Draw line” tool appears as the Draw Line tool. 

Open Greenshot 

See Open Greenshot After Installation. 

Capture an image and open the Greenshot editor 

1. With Greenshot open, press the Print Screen key on your keyboard.  

2. Use the crosshairs to select an area of your screen.  

3. Capture an image of your screen, as follows:  

a. Left-click and hold your mouse button while dragging the crosshairs over the portion of the screen 
you want to capture. 

b. Release the left mouse button when you have selected the area you want to capture. 

4. A Greenshot menu appears with options for the image you have captured. 

5. Choose Open in image editor from the Greenshot menu, as shown here. 

 

6. The Greenshot image editor opens with the captured screen image 

Selection Tool 

The Selection Tool icon shown at left is the top icon on the vertical toolbar. 

On the vertical toolbar, click the Selection Tool icon shown at left. It lets you work with objects 

you have already added to the image or change the focus within the Greenshot image editor. 

Some uses for the Selection Tool: 

• Select an object. Select and object to move it, resize it, or add formatting to it. 

• Deselect an object. After working with an object, it can be helpful to deselect it by clicking the Select 

Tool. This can help prevent unwanted move or resize changes. 

• Remove focus from another tool, such as Draw Arrow, to keep it from creating new objects each 

time you click on the image.  
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Draw Rectangle 

The Draw Rectangle tool icon shown at left appears at the top of the vertical toolbar.  

This tool lets you add square or rectangle shapes to an image you have open in the Greenshot 

image editor. You can then customize the shape using the formatting features. 

Some uses for the Draw Rectangle tool 

• Outline an area of the image. Draw a rectangle around an area of an image to outline it. You can 

create a transparent background and choose the color and thickness of the rectangle border. 

• Obscure an area of the image. You can place a rectangle over an area of an image you want to 

redact. Then create an opaque background and choose a border style or remove the border. 

Using the Draw Rectangle tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Draw 
Rectangle icon. 

Result: The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start your rectangle. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want your 
rectangle to end.  

4. Release the left mouse button.   

Result: The rectangle object is placed on the image.  

5. To move or change the rectangle shape:  

a. Click the Selection Tool to deselect the Draw Rectangle tool—this prevents the Draw Rectangle 
tool from creating unwanted objects when you click on the image.  

b. Click the rectangle shape to select it. 

Result: You can drag the object to the desired location or use the object handles to change the size 
and shape of the rectangle. 

Formatting a rectangle object 

To use the formatting options, the rectangle object must be selected in the Greenshot image editor. 

6. Use the Selection Tool to select a rectangle object in the Greenshot image editor.  

7. Choose formatting options: Use the formatting toolbar options to change the rectangle as desired. 

 

Note: The color shown on the fill and line icons matches the color of the currently selected object.  
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8. Fill Color (background): Click the Fill color icon ( ) and use the 

color picker to choose a background color for the rectangle. You can 
also choose a transparent background.  

Click Apply to add your background choice to the rectangle object.  

9. Line Color: Click the Line color icon ( ) and use the color picker (as 

shown at right) to choose a color for the rectangle’s line (border).  

You can also choose a transparent line, but see the line thickness 
discussion below. 

Click Apply to add your line color choice to the rectangle object.  

10. Line Thickness: Use the arrows on the Line thickness counter ( ) to toggle the 

number up or down. This changes the thickness of the rectangle’s line or border to the desired width.  

The line disappears from the object when you set the counter to zero (0). 

11. Drop Shadow: Click the Drop shadow icon ( ) to add a drop shadow to the shape, as shown here.  

 

Click the Drop shadow icon again to remove the drop shadow from the object. 

Draw Ellipse 

The Draw Ellipse tool icon shown at left appears near the top of the vertical toolbar.  

This tool lets you add circle or oval shapes to an image you have open in the Greenshot image 

editor. You can then customize the shape using the formatting features. 

Some uses for the Draw Ellipse tool 

• Outline an area of the image. Draw an ellipse around an area of an image to outline it. You can 

create a transparent background and choose the color and thickness of the ellipse border. 

• Obscure an area of the image. You can place an ellipse over an area of an image you want to 

redact. Then create an opaque background and choose a border style or remove the border. 

Using the Draw Ellipse tool 

See Using the Draw Rectangle Tool. The instructions for using the Draw Ellipse tool are identical.  

Formatting an ellipse object 

See Formatting a Rectangle Object. The instructions for formatting an ellipse object are identical. 

Draw Line 

The Draw Line tool icon shown at left is about a quarter of the way down the vertical toolbar.  

This tool lets you add lines to an image you have open in the Greenshot image editor. You can 

then customize the shape using the formatting features. 
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Some uses for the Draw Line tool 

• Connecting other shapes. Draw a line from one shape to another to indicate a connection. 

Using the Draw Line tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Draw Line 
icon. 

Result: The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start your line. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want your 
line to end.  

4. Release the left mouse button.   

Result: The line object is placed on the image.  

5. To move or change the line shape:  

a. Click the Selection Tool to deselect the Draw Line tool—this prevents the Draw Line tool from 
creating unwanted objects when you click on the image.  

b. Click the line shape to select it. 

Result: You can drag the object to the desired location or use the object handles to change the 
length of the line. 

Formatting a line object 

To use the formatting options, the rectangle object must be selected in the Greenshot image editor. 

1. Use the Selection Tool to select a rectangle object in the Greenshot image editor.  

2. Choose formatting options: Use the formatting toolbar options to change the line as desired. 

 

Note: The color shown on the line icon matches the color of the currently selected object. 

3. Line Color: Click the Line color icon ( ) and use the color picker 

(shown at right) to choose a color for the line.  

You can also choose a transparent line, but see the line thickness 
discussion below. 

Click Apply to add your line color choice to the line object.  

4. Line thickness: Use the arrows on the Line thickness counter  

( ) to toggle the number up or down. This changes 

the thickness of the line to the desired width.  

The line is no longer visible when you set the counter to zero (0). 
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5. Drop Shadow: Click the Drop shadow icon ( ) to add a drop shadow to the shape, as shown 

here—not very visible on this line.  

 

Click the Drop shadow icon again to remove the drop shadow from the object. 

Draw Arrow 

The Draw Arrow tool icon shown at left is about a third of the way down the vertical toolbar.  

This tool lets you add arrows to an image you have open in the Greenshot image editor. You can 

then customize the shape using the formatting features. 

Some uses for the Draw Arrow tool 

• Calling out image features. Add an arrow to an image to point out a feature of the image. 

• Connecting other shapes. Draw an arrow from one shape to another to indicate a connection or 

progression, such as in a flowchart. 

Using the Draw Arrow tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Draw Arrow 
icon. 

Result: The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start your arrow (the tail end). 

Note: You start the arrow at the tail and end it with the arrowhead. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want your 
arrow to end (the arrowhead end).  

4. Release the left mouse button.   

Result: The arrow object is placed on the image.  

5. To move or change the arrow shape:  

a. Click the Selection Tool to deselect the Draw Arrow tool—this prevents the Draw Arrow tool from 
creating unwanted objects when you click on the image.  

b. Click the arrow shape to select it. 

Result: You can drag the object to the desired location or use the object handles to change the 
length of the line. 

Formatting an arrow object 

To use the formatting options, the rectangle object must be selected in the Greenshot image editor. 

1. Use the Selection Tool to select a rectangle object in the Greenshot image editor.  

2. Choose formatting options: Use the formatting toolbar options to change the line as desired. 
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Note: The color shown on the line icon matches the color of the currently selected object. 

3. Line color: Click the Line color icon ( ) and use the color picker (shown below) to choose a color 

for the line.  

You can also choose a transparent line, but see the line thickness discussion below. 

 

Click Apply to add your line color choice to the line object.  

4. Line thickness: Use the arrows on the Line thickness counter ( ) to toggle the 

number up or down. This changes the thickness of the line to the desired width.  

The line is no longer visible when you set the counter to zero (0). 

5. Drop shadow: Click the Drop shadow icon ( ) to add a drop shadow to the shape, as shown 

here—not very visible on this line.  

 

Click the Drop shadow icon again to remove the drop shadow from the object. 
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Draw Freehand 

The Draw Freehand tool icon shown at left appears near the middle of the vertical toolbar.  

This tool lets you use your mouse to draw a line on an image you have open in the Greenshot 

image editor. You can then customize the shape using the formatting features. 

Some uses for the Draw Freehand tool 

• Creating customized lines. Draw any shape you can, hand-write any text, or use the tool to black 

out (redact) areas of an image. 

Using the Draw Freehand tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Draw 
Freehand icon. 

Result: The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start drawing. 

3. Left-click your mouse and hold the button while dragging the pointer over the image to draw the 
shape you want.   

4. Release the left mouse button when you’re finished drawing. 

5. Repeat the steps above to create additional drawings on the image. 

Result: The arrow object is placed on the image.  

6. To move a drawn object:  

a. Click the Selection Tool to deselect the Draw Freehand tool—this prevents the Draw Freehand 
tool from creating unwanted objects when you click on the image.  

b. Click the shape you have drawn to select it. 

Result: You can drag the object to the desired location. 

Formatting a drawn object 

To use the formatting options, the object you’ve drawn must be selected in the Greenshot image editor. 

1. Use the Selection Tool to select a rectangle object in the Greenshot image editor.  

2. Choose formatting options: Use the formatting toolbar options to change the line as desired. 

 

Note: The color shown on the line icon matches the color of the currently selected object. 
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3. Line color: Click the Line color icon ( ) and use the color picker 

(shown at right) to choose a color for the line.  

You can also choose a transparent line, but see the line thickness 
discussion below. 

Click Apply to add your color choice to the object you’ve drawn.  

4. Line thickness: Use the arrows on the Line thickness counter  

( ) to toggle the number up or down. This changes 

the thickness of the line you’ve drawn to the desired width.  

The line is no longer visible when you set the counter to zero (0). 

Add Textbox 

The Add Textbox tool icon shown at left appears about halfway down the vertical toolbar.  

This tool lets you add a square or rectangle textbox to an image you have open in the 

Greenshot image editor. You can then customize the text and the shape using the formatting 

features. 

Adding a textbox is a great way to provide key information to readers within the body of an image.  

Using the Add Textbox tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Add Textbox 
icon. 

The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start your textbox. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want your 
textbox to end.  

4. Release the left mouse button.   

The textbox object is placed on the image.  

5. To add text, move, or change the textbox shape:  

a. Click the Selection Tool to deselect the Add Textbox tool—this prevents the Add Textbox tool 
from creating unwanted textbox objects when you click on the image.  

b. Click the textbox shape you created to select it. 

c. Double-click within the textbox shape to add text. 

You can drag the object to the desired location or use the object handles to change the size and 
shape of the rectangle. 
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Formatting a textbox object 

To use the formatting options, the textbox object must be selected in the Greenshot image editor. 

Tip: All text formatting options change all text within a textbox when applied.  

1. Use the Selection Tool to select a textbox object in the Greenshot image editor.  

2. Choose formatting options: Use the formatting toolbar options to change the textbox as desired. 

 

Note: The color shown on the fill and line icons matches the color of the currently selected object.  

3. Fill color (background): Click the Fill color icon ( ) and use the 

color picker to choose a background color for the textbox. You can 
also choose a transparent background.  

Click Apply to add your background choice to the textbox object.  

4. Line Color: Click the Line color icon ( ) and use the color picker (as 

shown at right) to choose a color for the rectangle’s line (border).  

You can also choose a transparent line, but see the line thickness 
discussion below. 

Click Apply to add your line color choice to the rectangle object.  

5. Line thickness: Use the arrows on the Line thickness counter ( ) to toggle the 

number up or down. This changes the thickness of the textbox’s line or border to the desired width.  

The line is no longer visible when you set the counter to zero (0). 

6. Font selection: Click the dropdown arrow on the Font Selection tool ( ) to 

select a different font for the textbox. The change applies to all text within the textbox. 

Greenshot provides numerous font options, including common sans serif fonts like Arial and Calibri, 
as well as serif fonts like Times New Roman, Georgia, and Courier New.  

7. Font size: Use the arrows on the Font Size counter ( ) to toggle the font size up or down.  

The change applies to all text within the textbox. 

8. Bold and italic: Click the Bold or Italic ( ) buttons to apply that format to the selected textbox. 

Click again to remove the formatting. The changes apply to all text within the textbox. 

9. Horizontal and vertical text alignment: Click the Horizontal alignment ( ) or Vertical alignment 

( ) buttons to change the text alignment within the textbox.  

— Horizontal alignment aligns the text at left, center, or right within the textbox. 

— Vertical alignment aligns the text at top, middle, or bottom within the textbox. 
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10. Drop shadow: Click the Drop shadow icon ( ) to add a drop shadow to the shape, as shown here.  

 

Click the Drop shadow icon again to remove the drop shadow from the object. 
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Add Speechbubble 

The Add Speechbubble tool icon shown at left appears halfway down the vertical toolbar.  

This tool lets you add text callout shapes to an image using the Greenshot image editor. 

The Greenshot speech bubble differs from the textbox in that has a directional callout tail that you can 

point to a specific area of the image. It also has rounded corners.  

Using the Add Speechbubble tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Add 
Speechbubble icon. 

The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start your speech bubble. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want your 
speech bubble to end.  

4. Release the left mouse button.   

The speech bubble object is placed on the image.  

5. To add text, move, or change the speech bubble shape:  

a. Click the Selection Tool to deselect the Add Speechbubble tool—this prevents the Add 
Speechbubble tool from creating unwanted speech bubble objects when you click on the image.  

b. Click the speech bubble shape you created to select it. 

c. Double-click within the speech bubble shape to add text. 

You can drag the object to the desired location or use the object handles to change the size and 
shape of the rectangle.  

You can also drag the speech bubble’s callout tail 360 degrees around the object, change its 
direction, and extend or shorten its length. 

Formatting a speech bubble object 

To use the formatting options, the speech bubble object must be selected in the Greenshot image editor. 

Tip: All text formatting options change all text within a speech bubble when applied.  

1. Use the Selection Tool to select a textbox object in the Greenshot image editor.  

2. Choose formatting options: Use the formatting toolbar options to change the speech bubble object 
as desired. 

 

Note: The color shown on the fill and line icons matches the color of the currently selected object.  
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3. Fill color (background): Click the Fill color icon ( ) and use the 

color picker to choose a background color for the speech bubble. You 
can also choose a transparent background.  

Click Apply to add your background choice to the speech bubble 
object.  

4. Line color: Click the Line color icon ( ) and use the color picker (as 

shown at right) to choose a color for the speech bubble’s line (border).  

You can also choose a transparent line, but see the line thickness 
discussion below. 

Click Apply to add your line color choice to the speech bubble object.  

5. Line thickness: Use the arrows on the Line thickness counter ( ) to toggle the 

number up or down. This changes the thickness of the speech bubble’s line or border as desired.  

The line is no longer visible when you set the counter to zero (0). 

6. Font selection: Click the dropdown arrow on the Font Selection tool ( ) to 

select a different font for the speech bubble. The change applies to all text within the speech bubble. 

Greenshot provides numerous font options, including common sans serif fonts like Arial and Calibri, 
as well as serif fonts like Times New Roman, Georgia, and Courier New.  

7. Font size: Use the arrows on the Font Size counter ( ) to toggle the font size up or down.  

The change applies to all text within the speech bubble. 

8. Bold and italic: Click the Bold or Italic ( ) buttons to apply that format to the selected textbox. 

Click again to remove the formatting. The changes apply to all text within the speech bubble. 

9. Horizontal and vertical text alignment: Click the Horizontal alignment ( ) or Vertical alignment 

( ) buttons to change the text alignment within the speech bubble.  

— Horizontal alignment aligns the text at left, center, or right within the speech bubble. 

— Vertical alignment aligns the text at top, middle, or bottom within the speech bubble. 

10. Drop shadow: Click the Drop shadow icon ( ) to add a drop shadow to the shape, as shown here.  

 

Note that Greenshot adds a drop shadow to the text as well as to the speech bubble.  

Click the Drop shadow icon again to remove the drop shadow from the object. 
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Add Counter 

The Add Counter tool icon shown at left appears halfway down the vertical toolbar.  

This tool lets you add numbered circles to an image using the Greenshot image editor. 

Each time you click the image with this tool selected, Greenshot adds another object, advancing the 

count of the number by one.  

Using the Add Counter tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Add Counter 
icon. 

The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start your counter. 

3. Left-click your mouse—the counter is placed on the image with the number 1.  

4. Left-click your mouse again to place another counter on the image with the number 2, and so on.   

5. To move or change the Add Counter shape:  

a. Click the Selection Tool to deselect the Add Counter tool—this prevents the Add Counter tool 
from creating unwanted objects when you click on the image.  

b. Click the counter shape you created to select it. 

c. Double-click within the counter shape to manually type the number. 

You can drag the object to the desired location or use the object handles to change the size and 
shape of the object.  

Formatting a counter object 

To use the formatting options, the counter object must be selected in the Greenshot image editor. 

1. Use the Selection Tool to select a counter object in the Greenshot image editor.  

2. Choose formatting options: Use the formatting toolbar options to change the counter as desired. 

 

Note: The line color icon sets the color for the number within the counter object. The color shown on 
the fill and line icons matches the color of the currently selected object.  

3. Fill color (background): Click the Fill color icon ( ) and use the 

color picker to choose a background color for the counter. You can 
also choose a transparent background.  

Click Apply to add your background choice to the textbox object.  

4. Number color: Click the Line color icon ( ) and use the color picker 

to choose a color for number shown within the counter.  

You can also choose a transparent number, but it is not visible on the 
object. 
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Click Apply to add your color choice to the number within the counter object. 

5. Set number value: Use the arrows on the number value counter ( ) to toggle the number up or 

down. This action also makes corresponding changes to the numbering for all other counter objects 
you will place or have already placed.  

You can also click within the counter and manually type the number for the object. 
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Highlight 

The Highlight tool icon shown at left appears toward the bottom of the vertical toolbar.  

This tool lets you highlight an area of an image in a variety of ways. 

Using the Highlight Tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Highlight icon. 

The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start highlighting. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want the 
highlighting to end.  

4. Release the left mouse button.   

The highlight object is placed on the image.  

5. To move or change the highlight shape:  

a. Click the Selection Tool to deselect the Highlight tool—this prevents the Highlight tool from 
creating unwanted highlighting objects when you click on the image.  

b. Click the highlight shape you created to select it. 

You can drag the object to the desired location or use the object handles to change the size and 
shape of the highlight object.  

Highlight Tool formatting and options 

Greenshot provides helpful options for highlighting your images.  

As the formatting toolbar image at right shows, when the Greenshot Highlighting 

tool is active, you can click the dropdown arrow on the toolbar to see a menu with 

four options for highlighting your image.  

This section talks about each of these options.  

When selected, the Highlight tool provides four options to format the highlighting for your image. 

• Highlight text 

Highlight text creates a typical colored highlighting effect. It’s the default option when you select the 

Highlight tool. You use the crosshairs pointer to outline an area of your image to highlight in color.  

 

You can use the following formatting toolbar options to change the appearance of the fill color, line 

color, line thickness, and drop shadow.  
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• Highlight area  

The Highlight Area option lets you highlight an area of your image by dimming the rest of the image 

with gray highlighting. 

 

For this option, Greenshot lets you control the following formatting options: fill (highlight) color, line 

color, line thickness, blur radius, brightness, preview quality, and drop shadow. 

 

— Blur radius blurs the unhighlighted image area.  

— Brightness dims or brightens the unhighlighted image area. 

— Preview quality may have a slight effect on the blurred area of the image, but if so, the effect 

seems to be minimal at best. Any other effect of changing this setting is unclear to this user. 

• Grayscale 

For colorful images, the Grayscale option sets the unhighlighted area of the image in grayscale, while 

leaving the color intact on the highlighted area.  

 

Formatting options for this effect include adding a line (border) around the highlighted area, changing 

line color and thickness, and adding a drop shadow to the border.  

 

• Magnify  

With the Magnify highlighting option, you can increase the size of the highlighted area of an image.  

  

With the formatting options, you can add a line (border) around the highlighted area, change line color 

and thickness, and you can control the level of magnification from a factor of two up to a factor of 

eight. You can also add a drop shadow to the border. 

 

 



 Using the Greenshot Screen Capture Tool  Page 31 of 39 

Scott Weiss—Technical Writing Sample  Using Greenshot’s Features 

Obfuscate 

The Obfuscate tool icon shown at left appears near the bottom of the vertical toolbar.  

With this tool you can obscure areas an area of an image using pixelation or blurring. 

See Obfuscation Tool Formatting and Options below for more on choosing pixelation or blurring.  

Using the Highlight tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Obfuscate 
icon. 

The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start the obfuscation. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want the 
obfuscation to end. 

4. Release the left mouse button.   

The obfuscation object is placed on the image.  

5. To move or change the obfuscation object:  

a. Click the Selection Tool to deselect the Obfuscate tool—this prevents the Obfuscate tool from 
creating unwanted objects when you click on the image.  

b. Click the obfuscation shape you created to select it. 

You can drag the object to the desired location or use the object handles to change the size and 
shape of the obfuscation object.  

Obfuscate Tool options and formatting 

Greenshot provides helpful options for obfuscating your images.  

As the formatting toolbar image at right shows, when the Greenshot Obfuscate 

tool is active, you can click the dropdown arrow on the toolbar to see a menu 

where you can choose pixelation or blurring.  

This section talks about each of these options. 

When selected, the Highlight tool provides four options to format the highlighting for your image. 

• Choosing pixelation 

The Pixelize option creates a pixelated effect. You use the crosshairs pointer to outline an area of 

your image to add pixelation.  

 

You can use the following formatting toolbar options to format line (border) color, line thickness, pixel 

size, and drop shadow. A larger pixel size increases the obfuscation. 
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• Choosing blurring 

The Blur option lets you highlight an area of your image by dimming the rest of the image with gray 

highlighting. 

 

For this option, Greenshot lets you control the following formatting options: fill (highlight) color, line 

color, line thickness, blur radius, brightness, preview quality, and drop shadow. 

 

— Blur radius increases the blurring effect when you set the number higher.  

— Preview quality may have a slight effect on the blurred area of the image, but if so, the effect 

seems to be minimal at best. Any other effect of changing this setting is unclear to this user. 

Effects 

The Effects tool icon shown at left appears near the bottom of the vertical toolbar. 

With this tool you can add effects to an image. 

This guide does not cover this tool in detail, but clicking the Effects icon in 

the vertical toolbar provides a menu with the options shown at right.  

 

The following points summarize these options:  

• Border: Adds a border to the entire image. Repeating the option selection increases the border width. 

• Drop shadow: Adds a drop shadow to the entire image. Repeating the option selection increases the 

drop shadow width. 

• Torn edge: Adds a torn edge effect to the entire image. Repeating the option selection increases the 

width of the torn edge. 

• Grayscale: Removes colors and turns the entire image to grayscale. 

• Invert: For the entire image, inverts light and dark and seems to change colors to their opposites on 

the color wheel. 
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Crop 

The Crop tool icon shown at left appears near the bottom of the vertical toolbar.  

This tool lets you crop an image to the area you want to keep. 

This tool functions in similar fashion to other common crop tools. 

Using the Crop tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Crop icon. 

The crosshairs appears when your mouse pointer hovers over the image.  

2. Use the crosshairs to place the pointer over the spot where you want to start cropping your image. 

3. Left-click your mouse and hold the button while dragging the pointer to the spot where you want the 
cropping to end. 

4. Release the left mouse button.   

The crop window outlines the area of the image to be kept after cropping.  

5. To change the cropped area:  

a. Use the handles on the sides and corners of the cropped area to adjust the area you want to 
keep.  

Note the options in the horizontal toolbar area of the Greenshot image editor:  

 

6. Do one of the following to confirm or cancel the cropped area:  

a. Click the green checkmark ( ) to confirm and keep the cropped area.  

b. Click the red cancel icon ( ) to return the image to its original, uncropped state. 
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Rotate Clockwise 

The Rotate Clockwise tool icon shown at left appears near the bottom of the vertical toolbar.  

This tool lets you rotate your entire image clockwise 90 degrees at a time. 

This feature is useful when working with an image of an entire document page.  

For example, when capturing an image of a full-page document in another application, it may be difficult 

to capture the document at an acceptable magnification level. 

If the other application allows, you may be able to rotate the document 90 degrees to view it on its side.  

Then you can use Greenshot to capture an image of the document on its side and rotate the image 90 

degrees in the Greenshot image editor to work on it. 

Using the Rotate Clockwise tool 

1. With an image open in the Greenshot image editor, use your mouse to left-click the Rotate 
Clockwise icon. 

The image rotates 90 degrees clockwise.  

2. Click the Rotate Clockwise icon again to rotate the image another 90 degrees, and so on, as needed. 

See also the Rotate Counter Clockwise tool.  
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Rotate Counter Clockwise 

The Rotate Counter Clockwise icon at left appears near the bottom of the vertical toolbar.  

This tool lets you rotate your entire image counterclockwise 90 degrees at a time. 

This feature is useful when working with an image of an entire document page. 

For example, when capturing an image of a full-page document in another application, it may be difficult 

to capture the document at an acceptable magnification level. 

If the other application allows, you may be able to rotate the document 90 degrees to view it on its side.  

Then you can use Greenshot to capture an image of the document on its side and rotate the image 90 

degrees in the Greenshot image editor to work on it. 

Using the Rotate Counter Clockwise tool 

1. With an image open in the Greenshot image editor, use your mouse to left-click the Rotate Counter 
Clockwise icon. 

The image rotates 90 degrees counterclockwise.  

2. Click the Rotate Counter Clockwise icon again to rotate the image another 90 degrees 
counterclockwise, and so on, as needed. 

See also the Rotate Clockwise tool.  
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Resize 

The Resize icon shown at left appears at the bottom of the vertical toolbar.  

This tool lets you resize your image within the Greenshot image editor. 

Using the Resize tool 

1. With an image open in the Greenshot image editor, left-click your mouse to select the Resize icon. 

The Resize settings window appears, showing the width and height of your image.  

 

2. Change the height and width of the image as desired.  

3. You can click the dropdown to choose whether to measure the size of your image in pixels or by 
percentage, as outlined in red here.  

 

4. Check or uncheck the Maintain aspect ratio box, depending on whether or not you want to make 
proportional changes to both the height and width of the image. 

5. Click Ok when you are finished. 

The image has been resized according to the changes you made.  
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5. Copying and saving images 

Greenshot lets you work with your images by saving, copying and pasting, or printing them. The options 

appear on the Greenshot File menu, as shown here. This section discusses these options. 

 

Choosing Close simply closes the Greenshot image editor, giving you the chance to save any changes. 

Copy to clipboard 

To copy the image in the Greenshot image editor so you can paste it into another application, such as a 

word processing program, choose one of the following options:  

• Click the Copy image to clipboard icon ( ). 

• Click the File menu and choose Copy to clipboard from the menu. 

Both options copy the entire image to the clipboard to paste into another application or Greenshot image. 

Save as 

With the Save as feature, you can choose to save your image as any of the following image types: 

• BMP 

• GIF 

• JPG 

• PNG 

• TIFF 

• Greenshot 

• ICO 

Choosing the Greenshot option lets you reopen the image with any changes you’ve made or objects 

you’ve added. This is helpful for addressing future revisions.  

The scope of this document does not include addressing the various image formats.  
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Save directly 

Choosing Save directly saves the image using the default image format and output destination.  

• To change the default format: On the Edit menu, choose Preferences > Output. Then make a 

selection using the Image Format field dropdown menu.  

• To change the default file save location: On the Edit menu, choose Preferences > Output. Then 

type or browse to choose the storage location using the Storage Location field.  

Send to printer 

Choosing the Send to printer option shows you a menu where you can choose from the printer options 

set up for your computer. This includes options to print to a Portable Document Format (PDF).  
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6. References 

Sources for this guide 

Greenshot image editor:  

• Version 1.2.10.6 (64-bit) 

To download and install Greenshot 

• getgreenshot.org/ 

Greenshot Open Hub® page:  

• www.openhub.net/p/greenshot 

• Licenses:  

Greenshot is licensed under the GNU General Public License v2.0 or later  

www.openhub.net/licenses/gpl 

Greenshot GitHub repository:  

• github.com/greenshot 

Greenshot help:  

• getgreenshot.org/help/ 


